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Introduction

Data Converter isatool for converting data files from one format to another. Y ou define the input and output file formats and Data Converter performs
the task of moving the data between various file formats, for example between a COBOL datafile and a CSV (Comma Separated Values) format file.

It can also convert between different character code systems, such as between ASCII and EBCDIC, or ASCI| and Unicode.

ToUseHelp

- Please use abrowser that supports HTML 3.2 (Netscape Navigator V4.03 or newer, or Internet Explorer V3.02 or newer).

- For simplicity, this online manual refersto either NetCOBOL or COBOL generically as"COBOL". The "Data Converter - Readme" topic defines
the relationship between "NetCOBOL" or "COBOL" and Data Converter.

Export Regulation

Exportation/rel ease of this document may require necessary procedures in accordance with the regulations of your resident country and/or US export
control laws.

Trademarks

The registered trademarks used within this online manual are asfollows.
- NetCOBOL isatrademark or registered trademark of Fujitsu Limited or its subsidiaries in the U.S.A. and other countries or in both.

- Microsoft, Windows, Windows Server, Visual C++, and Visual Basic are the registered trademarks of Microsoft Corporation in the U.S.A. and other
countries.

- UNIX isaregistered trademark in the U.S.A. and other countries, licensed exclusively through X/Open Company Limited.

- Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.
Oracle Solaris might be described as Solaris, Solaris Operating System, or Solaris OS.

- Other company names and product names are the trademarks or registered trademarks of the respective companies.

Abbreviations

In this online manual, the following product abbreviations are used:

Microsoft Windows - All releases "Windows"

Copyright 1994-2015 FUJITSU LIMITED



Function Outline
. Data Converter supports ASCII, EBCDIC, and Unicode systems. Other codes can be processed with the User
Code Conversion Option

Data Converter understands all COBOL data types such as packed decimal and binary data. 1t supports
Data Conversion converting individual fields between different data types. Items are converted according to the descriptions set
up in the Invoking the L ayout Definition Utility .

File Organization Conversion Data Cor_lverter supports the conversion between XML files, COBOL Files, binary files, text files, and CSV
format files.
Preview A preview function allows you to verify that the data conversion has been successful.

Data Converter is integrated with Data Editor so that data can be passed quickly and conveniently from Data
Integration with Data Editor Editor to Data Converter. Since Data Editor aready has all of the record information, you only need to specify
information in the last two steps of the Conversion Wizard.

1/0O of variable-length COBOL file | Data Converter supports I/O of variable-length COBOL files.

Multi L ayout Data Converter can handle multi format files.




Applications of Data Converter

The following are typical applications of Data Converter.

- Datatransfer utility for platform migration as in downsizing etc.

- Analysisand confirmation of files from other platforms

- Data exchange between various DBM S and spreadsheet software through CSV format
- Dataexchange between 16 bit and 32 hit platforms

- Data exchange between platforms with different bitwise data alignment

- Transferring data between COBOL datafiles and XML document files



|Eile| view| Tools| options|Help |

Menu Function Explanation

New Setup Invokes the Conversion Wizard to help you assemble the conversion information for a new conversion process.

Open Opens a conversion information file. Conversion information files can also be opened by dragging them from their source directory
and dropping them into Data Converter.

Note: The layout definition file referred to in the conversion information file must be available when the information file is opened.
Save Updates the conversion information file with any changes made.
Save As Saves the conversion information to a new conversion information file.
Exit Exits Data Converter. If you have not saved all of your changes, Data Converter prompts whether you want to save those changes.



| ile[View| Tools| options|Help |

Menu Function Explanation

Toolbar Switches display of the toolbar on and off.
Status Bar Switches display of the status bar on and off.
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Menu Function Explanation

Layout Definition Starts the Layout Definition Utility. - _Invoking the L ayout Definition Utility



Options Menu

|File[View| Tools|Options|Help |

Menu Function Explanation

Preferences Invokes the Data Converter Prefer ences dialog.



| Eilefview|Tools|options |Help|

Menu Function Explanation

Data Converter Help Displays the online manual .
About Data Converter Displays the Data Converter version information.
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Button Menu

File-New Setup
File-Open

File-Save

File-Save As
Tools-Layout Definition
Options-Preferences

Help-Data Converter Help
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L ayout Definition Utility - FileMenu

|i|e|@|L§yout|Vi;aN|Optionslﬂpl

Menu Function
New from COBOL library

New

Open
Save

Save As
Savein Old Version Format

Generate COBOL Library

Generate DTD

Explanation See Also
Utility automatically generates the item definition from a COBOL COPY Library. ->Analyzing COBOL
Library

Clearsthe display of the current layout definition in preparation for creating a new
layout definition file.

Opens an existing layout definition file.
Saves edits to the layout definition file. Checks the layout definition for correctness and
asks you whether or not to save thefileif it has errors.

Saves the layout definition file to anew file. Checks the layout definition for
correctness and asks you whether or not to save thefile if it has errors.

Saves the layout definition file in aformat that can be used by the previous version.

Creates a COBOL library containing information from the layout definition. Selectan > An Example of

object (input side/ output side) to create from Generate COBOL library . Generating a COBOL
Library

Generate DTD if the layout definition being edited isin XML format. ->An Example of
generating DTD

Replace Layout from Existing Layout Overwrites information on an existing layout definition file.

Replace Layout from COBOL file
Exit

Overwrites information on an existing COBOL file.
Closes the Layout Definition Utility.



Layout Definition Utility - Edit Menu

|m3|@|L§yout|Vi;aN|Optionslﬂpl

Menu Function
Cut

Copy

Paste

Insert

Delete

Append

Insert new layout
Add new layout
Edit layout condition
Delete layout

Explanation

Cuts the selected lineg(s) to the copy buffer.

Copies the selected line(s) to the copy buffer.
Inserts the contents of the copy buffer in front of the current line.
Inserts anew line before the current line.
Deletes the selected ling(s).

Adds anew line after the last line.

Inserts anew layout before the current layout.
Adds anew layout after the current layout.
Displays the Layout Definition Template.
Deletes the current layout.



Layout Definition Utility - Layout Menu

|m3|@|Lgyout|Vi;aN|Optionslﬂpl

Menu Function

Item Definition

Special File Encoding
Data Format

Operations on All Items

COBOL Library Analysis Option

Explanation

Displays the Item Definition Template for editing the information in the current line.
Sets treatment of Null Area, Null string terminators, and big endian behavior.

Sets and changes the data format of the input and output.

Provides alist of functionsto apply to all of the items.

Sets various options for analyzing COBOL libraries.



Layout Definition Utility - View Menu

|m3|@|L§yout|Vi;aN|Options|@pl

Menu Function Explanation

Toolbar Displays or hides the Toolbar.
Status Bar Displays or hides the Status Bar.

Reset Cell Sizes Resetsthe cell width of the item definition table and resizes the window.

Extended Display Displays or hides the Item Definition Extension information.

- _Understanding Item

Definition Information



Layout Definition Utility - Options Menu

| File|Edit | Layout | View [Options | Help |

Menu Function Explanation

Preferences Displays the Preferences option selection screen of the layout definition function.



Layout Definition Utility - Help Menu

|F|_Ie|@| Lgyoutl\/i;mlOptionslﬂpl

Menu Function

Data Converter Help
About Data Converter

Explanation

Displays the online manual.
Displays the version information.



L ayout Definition Utility - Toolbar
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Button Menu

File-New from COBOL library
File-New

File-Open

File-Save

File-Save As

Edit-Cut

Edit-Copy

Edit-Paste

Edit-Insert

Edit-Delete

Edit-Append

Edit-Insert new layout
Edit-Add new layout
Edit-Edit layout condition
Edit-Delete layout

Options-Preferences
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Help-Data Converter Help



Data Converter Preview function - File Menu

|i|e|09tions|ﬂp|

The File menu has asingle function - Exit. It returns you to the Data Converter main window or will exit from the Layout Definition tool.



Data Converter Preview function - Option Menu

|m3|Options|ﬂp|

Menu Function

HEX Display
Column Grid Lines
Display Conversion Errors

Explanation

Displays the data in hexadecimal underneath the ASCII characters.
Controls the spacing of the column lines. Select from lines every 10, 5 or 1 characters, or no gridlines.

Displays any errors that occurred in converting the first 100 records using the conversion error display —>Displaying
function. Conversion

Errors



Data Converter Preview function - Help Menu

|m3|0p_)tions|m;g|

The Help function invokes the Preview help.



Checking Conversion Using the Provided Sample Data

The following describes the procedure for using the samples provide with this product. Use these samples to check the operation of Data Converter after
installation, etc. Samplesinclude data values not matching item attributes to trigger the conversion error display function.

1. Activating Data Converter

& Fujitsu DataTools V3.0 [T |[E]X]
T ¥ I.‘ln

From the Start menu (or Program manager), click the Data Converter icon to start Data
Converter.

File Edit Yiew Favorites

i1

(€ Back \_,) Lﬁ

address |3 jitsu DataTools v3.0 ¥ | [ Go

| >

DataConwve... Layouk
Drefinition

2. Activating the Conversion I nformation Wizard

Select New Setup from the File menu or from the toolbar or select Conversion Wizard button
to activate the Conversion Wizard.

g3 Untitled - Data Converter

File Wiew Tools Options Help

Open. ., Chrl+0
SaE GhHHS
Save-hs..,

1] |

Conversion izard

Breview | [

Ready |

3. Conversion Information Wizar d(1/5)

Select File Conversion Mode Specify the file conversion mode and the default folder.

% [rata File Conversion [ converts data lapouts or
(" Tewt Conversion [ converts character code

Select Data File Conversion as the file conversion mode and specify the folder that stores
sample data (DATA1.DAT) as the default folder.

To use relative path names in the Conversion \Wizard
Diefault Folder: ||

4. Conversion Information Wizard(2/5)

- ! Specify alayout definition file. To create a new layout definition file, select Update to activate
the Layout Definition Program.

ed file, click here:

aJrary
COBOL library and
i sk B Srialiee.

5. Layout Definition Function (Create from COBOL library)




Click on the Update button to create a new Layout Definition File. Select Create from

n; Untitled - Layout Definitiomnns IEII‘EI ) ; i '
; COBOL library from the File menu to create it from COBOL library(DATAL1.CBL)

|Fle Edt Layout Yiew Options Help

e From COBOL library... ZhrlHR
M Chrl4M
DPER, . D
SENE CiTS
S EIE =

lﬂEICreate From COBOL ibrary|

6. Layout Definition Function (Specifying a Data For mat)

When the analysis of COBOL library is complete, the Data Format dialog is displayed.

Data Formiak E[

Specify the input and output data formats in this dialog.

Input Data Format 0 utput D ata Forrnat
L Select Data file asthe Input Data Format and CSV file as the Output Data For mat and click
+ Datafile " Datafile OK .
" C3Y file * LSV
WML file 4L file:
oK. I Cancel Help

7. Layout Definition Function (Checking, Saving, and Terminating a L ayout Definition)

The result of the analysisis displayed in thelist.

21 L Select Save from the File Menu or toolbar, or Save As and enter anew name. (The extension
| Lv| Repeat] ltemname Atk S SAY)-
1)L | DRDERND it The sample layout definition file (DATAL.LAY) is analyzed and saved in this manner.
= IR | PRODUCTNO A
i g [ EEE:[EU CTHAME | é After saving the data, terminate the layout definition function and return to the Data Converter's
£ 0 ' SALESNUMBER = Conversion Information Wizard (Step 2 of 5).
B 0 | SAlES |12
70 | SALESDATE [
8 0 | CUSTOMERMAME LA
4 0 | CUSTCODE L

8. Conversion Information Wizar d(2/5 After making the layout definition file)

Specify the file name saved by the layout definition function for the layout definition file name.

Specify Layout Definition File

Eile riarme: IData'I ay

9. Conversion I nformation Wizard(3/5)

Specify input information.

Specify ASCI|I asthe code system, the sample data (DATAL.DAT) as the file name, and
Binary or Text File asthefile format.

Specify Fixed Length asthe record attribute and 116 as the record length.




Code system: | A5CII =

- Specify Data Format Option

File name: IData'I .dat

@ Fised
" Yariahle

— Specify Record Attibute

Fi]a Tuvpe: |Einar_l,l aor Text file ll

Mew Line Code: INE'

Becord Lemgth: I'I'IE E

Record Length from Layout Def

10. Conversion Information Wizar d(4/5)

Specify output information.

Specify ASCII asthe code system, any file name as the file name (DATA1.CSV by default),
Variable length as the record attribute, and New line code (CR+LF) as the delimiter of

records.

_E Additionally, click on Setup to bring up the CSV Information Setup dialog and set up the

CSV format for output.

Code spstem: | A5CII ~]
File name: |Dat_a1 v
- Specify Data Fomat Option
File Type; |Ei|'nar_l.l or Tt file j
- Specify Fecord Attibute -
" Figed Mew Line Code: |New line cc
AecordLengh [T =)
Hepnrd [Lepath rany Lapout e

11. Specifying CSV | nformation

rirchirzk rerard

'+ areerrion Wizerd - S Sof

Db i .

a using double quates
ter as double quotes

12. Conversion Information Wizar d(5/5)

diriter: [ = r Tah (4) SQLServer

Specify CSV information settings.

From the reference settings, select Oracle. The general loader format of Oracle will be
selected.

Click OK and go to Conversion Information Wizard Step 5 of 5.

1 E:J:J"_'Eli:]E:. [
£2) Infarmix.
(3} SymFoWARE
(5} Excel
= B O Ll

=

- Specky s Fin it —
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Cornmzan Erva Lk

Wit o 1
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™ Conints even i s sspesd the ind

Specify other information on conversion.

Thisinformation can be changed as required. It isrecommended that the default settings be used
for asample.

Click Finish to complete the Conversion Information Wizard.

Click the Preview button to bring up the preview screen.
Check that the dataisin CSV format.

Select Exit from the File menu to close the Preview screen.




Conversion Wizard Preview

s ; 1 ;

.I 1 1 1 I 1 1 1 1 I 1 1 1 1 I 1 1 1 L
I [rmesi1o0—=ma—o1", "H=z7a9;

F2S0303531 0704120303122 2C220032373038;
¢ ["Toslo0—m—01~, "H= 7439;

F2S0303531 0704120303122 2C220032373038;
I ["rTesilo—m—o=", "H= 74a9;

P 2S0303531 0704120303222 2C220032373038;
¢ ["rTeETo_—EBE—o01v, "THE=7=

P25 0303531 0704220303122 2203633 3TAE;
5 ["TesE1l0—BE—o0="~, "THE= 7=
Breview: Corveert hzplay

Data Converter
@ S selerl Aeenal),

Humber of input records: 18 )
Humber of output records: 16 Number of errors: O

Click the Convert button to start the actual conversion processing.

When the conversion processing is complete, a dialog will display the input and output record
counts and the error occurrence count.

The results displayed for the sample data are asfollows :

Number of input records: 16
Number of output records: 16
Number of errors: 0

15. Saving a Conversion Information File

4 Untitled - Data Converter

File Yiew Tools Options Help

Mew Setup TEelR
PR, Chrl4

SaVE il +S

B|=(u]w] 2 ¥ @

Item [eove pn Ll Setup Valus
AT

rrarnee Tnfarm

Select Save As from the toolbar to save the conversion file (with the extension of "CIF").

16. Terminating Data Converter

=4 Uintitled - Data Converter

File Miew Tools ‘Options  Help

New Setup  Ctrl-+ _J
Open.,.  Chri+0 b ﬁl
: alue

SavE CirlS

SEYE G5

[-Atest Fles

‘gl

Select Exit from the File menu to terminate Data Converter.




The Conversion Process

Follow these stepsto convert files using Data Converter.
1. Prepareinput filefor conversion.

If you want to convert files created on other machines such as UNIX workstations or mainframes, you must first transfer them to the PC environment.
Since most file transfer programs do not understand COBOL file organizations or field types, it is best to transfer the files as binary files to ensure no
character conversion is attempted.

2. Run the Conversion Wizard to set up the conversion information.

Data Converter uses a set of information that it stores in a conversion information file (conversion file, for short). Y ou enter and edit this information by
running the Conversion Wizard. The key information required is:
Conversion mode: Select either Data File Conversion or Text Conversion.

For datafile conversion, use the Layout Definition Utility to define the input and output file layouts and create a layout definition file. The Layout
Definition Tool analyzesa COBOL COPY library to give theinitial record layouts.

Specify the input file name and organization details.
Specify the output file name and organization details.
Confirm the error log name and options, and, if appropriate, a user-defined conversion table.

When you finish the Conversion Wizard process, you return to the Data Converter main window where all of the details are displayed.
3. Savethe conversion information.

It is best to save the conversion information in a Conversion Information File. This ensures that the information is available for future executions of the
file conversion.

4. Use Preview to check that the conversion is setup correctly.

Data Converter provides a preview function that displays the results of the conversion of the first 100 records. Y ou can verify that all of the conversion
details are correct before executing afull conversion run.

5. Execute the conversion.
Click the Convert button to execute the conversion.
6. Check for errors.

Data Converter reports the number of records converted and the number of errorsin the conversion. If there are errors, click on the Display Error
button to view the Conversion Error File.

7. Transfer the output fileto the tar get environment.

If the output fileis targeted at a UNIX or mainframe machine, use appropriate file transfer software to transfer the file to the target environment.
Aswith theinput file, it is best to transfer the files as binary files to ensure no character conversion is attempted.



Under standing Data Converter

Data Converter is used first to set up the conversion information and then to save it in a conversion information file. Y ou
then can then run conversions and check conversion results. Use the links below to explore the various functions of Data
Converter. The buttons at the base of the main window take you through the main sequence you need to follow to convert
files: invoking the Conversion Wizard, previewing the conversion, running the conversion, and reviewing any errors.

- Common Information (Step1)

- Layout Definition File Information (Step?)
- Input/Output File Information (Step3 & 4)
- Other Information (Step5)

- Conversion Information file



Executing the Conversion

Click on the Convert button to start the conversion. Data Converter will display a progress indicator containing:

- the name of theinput file

- the number of bytes converted

- the total number of bytesin thefile
- the number of conversion errors

- the percentage of progress

Y ou may interrupt the conversion process by clicking the Abort button. Aborting the conversion will discard the contents of the partially created output
file.

At the end of the conversion process, Data Converter will display the number of input records, output records, and conversion errors.



Using Data Converter - Executing Record Extraction

If the following message appears during conversion, check the conditional value in the data condition setting. For details, see Record Extraction
_Specifications.

For notes, see Notes on Record Extraction Function.

"Code conversion for an extraction condition failed.
The code of the n-th extraction condition has not been converted.
Normal extraction may not be assured with this condition"”.

n: Data condition serial number

Conversion accompanying record extraction is explained below.
If you have specified data conditions on Step 2 of the Data Converter Conversion Wizard, record extraction is performed. The processing subsequent to
record extraction is the same as for normal conversion.

When conversion accompanying record extraction is completed, information on the conversion is output, including the number of input records, the
number of output records, and the number of conversion errors.

Number of input Number of recordsin the input file.

records
Number of output Number of records that satisfy the data conditions.
records
Number of errors

Number of conversion errorsin the records extracted through record extraction.



Creating User Defined Conversion Tables

Data Converter supports ASCII, EBCDIC code, and Unicode character sets. Modifications or additions to these character
sets can be made through user-defined conversion tables. Character code conversions can be performed using custom-

designed or non-standard code sets by creating your own conversion tables. If desired, all single byte code sets can be
changed by defining 256 code conversion patterns in the user-defined conversion table. Caution: if thisis done, the user
must specify the ASCI, EBCD, or UCS2 portion of the code system definition.

Format for User Defined Conversion Tables - Conversion Wizard Step 5

User-defined conversion tables are text files that you create with any standard text file editor.

The conversion table consists of three types of lines:

Comment lines - these have a™*" in column 1

Code system definition lines - these have a' # in column 1
and

Code mapping lines - these have a space in column 1

Code system definition lines give the ID of the source and target code systems. When you convert files you enter the Code
ID to specify that a particular fileisin the defined code.

Code mapping lines follow each code system definition line. They give byte-to-byte (or double-byte to double-byte)
mappings.

Format for Code System Definition Lines

Code system name 1
Code system name 2

- #isspecified in column 1.
- Code system name can be ASCI, EBCD, or UCS2.

ASCI ASCII Code
EBCD EBCDIC Code
ucs2 UCS2 Code

- Code-system-name-1 is the code used in the input file.
Code system-name-2 is the code used in the output file.

Format for Code Mapping Lines

Character code 1
Character code 2

- Spaceis specified in column 1.

Character-code-1 and Character-code-2 are separated by a":" (colon) with no spaces.

- Character-codeisa?2 or 4 digit hexadecimal code (2 digits for single byte character sets, 4 digits for two byte
character sets)

- Character-code-2 can have the value NO. This means that no corresponding code is available.

- If there are multiple code mapping lines for the same character-code-1 value, the mapping defined in the last of
theselinesis used.

Example of a User Defined Conversion Table
(SAMPLE.CNV)

* Conversion from EBCDIC to ASCII,
* Substitute two values to the standard mapping
#EBCD ASCI
00:5F
5B:NO
* Conversion from ASCII to in-house code set by substituting
* al byte mappings in character set "EBCDIC"




# ASCI EBCD
00:00

20:40
21:44

* (Defines mappings for al byte values)




Previewing Conversion Results

Data Converter provides a preview function to help you check the conversion setup before running afull conversion.

Preview converts the first 100 records of the input file, and then displays the results.

Note: This function only works with binary, text, and CSV format files, and will not work for sequential, indexed, and relativefiles.

The display window has configurable column gridlines so you can easily check item positions. The display window also provides the option of viewing
the datain hexadecimal.



Displaying Conversion Errors

Data Converter stores errors encountered during conversion in aconversion error file. The conversion error display function displays - Conversion Error File
errors using an external viewer program (the default is a Notepad) specified by an option. ->Preferences

Example of a Conversion Error File
(SAMPLE.ERR)

*** Data Converter conversion error file ***
Current _Folder : V:\HOME\MDPORT32\TEST
Input File_: DATAL1.DAT
Layout definition Ffile : DATA1._LAY
Conversion error count : 2

[Sggg(ggnversion Error] Number of occurrences indicated in () (*)more than 100

[Error Items] Item No : Item name : Attribute (Number of errors occurred; "*" than 100)
3:Product name:N( 1

5:Sales volume:Z( 1

[Error Details] Record number-Position Error contents Item No : Item name : Attribute
3-23 Code Conversion Error OXOOOO? 3:Unit price:Z
e

4-46 Numeric part error 5:High sales:Z

[Code Conversion Error] | List of character codes that caused code conversion errors. For Unicode, UCS2 Big Endian is

displayed regardless of type (UCS2/UTF8) or Endian.
| Format | Hexadecimal -character-code (number-of-occurrences) |

[Error Items] List of items that contained conversion errors (data file conversion only)

|Format| Item-No- in-layout-definition : Item-name :Item-attribute (Number-of-errors) |

[Error Details] Provides a detailed breakdown of each conversion error in the order they occurred. The number

of errors reported is determined by the maximum specified in the Conversion Wizard. For
Unicode, displays Type (UCS2/UTF8) and Endian like the input code.

Format | I nput-record-number : Position-within-the-record Error-contents Item-No.-in-Layout-
definition : Item-name : Item-attribute

Using Data Converter - Displaying Conversion Errors- Examples of Typical Conversion Errors

Typica conversion errors and their causes are explained below.

Areaoverflow error - usually because of area length changes

After datafile conversion involving code conversion of aphanumeric character items, Japanese items, mixed items, variable-length character string items,
or variable-length national items, the input data length and output data length of the same item may not match.

Cause of area length changes
1 Conversion from ASCII/EBCDIC to Unicode (UCS2 format) was performed.
—>Inthe UCS2 format, all characters are represented by 2-byte codes.
2 Conversion from the CSV/XML format to the data format was performed.

>Inthe CSV/XML format, the length of each input item is variable. Therefore, the datalength ~ Use the layout definition function to increase the
after conversion may not match the output area length. If the data length after conversion is arealength of each output item.

shorter than the output area length, the non-data area is padded with null characters (or one-byte

spaces for some item attributes). If the data length after conversion islonger than the output area

length, extra characters are removed and an error is output.

Action

Code conversion error - code conversion error/incorrect conver sion

Cause of code conversion errors

3 Attemptsto convert LOW-VALUE (0x00) or HIGH-VALUE (OxFF) or extended ASCII code
result in aconversion error.

Action
Create a mapping table in a user-defined file.

Example:
- Because Data Converter does not recognize LOW / HIGH-VALUEs as characters, a =~ ===----—-—-
conversion error occurs and the LOW / HIGH-V ALUESs are replaced with specific aternate # ASCI ASCI
characters. 00:00
80:80
81:81
FF.FF

0000:0000



Errorsin numeric part - causes of errorsin numeric part

Causesof errorsin numeric part
Non-numeric data exists in an external/internal decimal data area.

| Attribute |[Sign|{ COPY clause |Internal representation (hex.) | Value||Error|
[External decimal[ No || 9(4) || 31323334 || 1234/ No |
[External decimal|| Yes||  So(4) || 31323344 ||[+1234/[ No |
[External decimal|[ No || 9(4) || 3132333A | o ves|
| Internal decimal || No || 9(4) COMP3 || 01234F || 1234/ No |
| Internal decimal || Y es|[S9(4) COMP3|| 01234D || -1234/| No |
| Internal decimal || No || 9(4) COMP3 || 012B4F | 0 Yes|

- A non-numeric character or symbol existsin a CSV/XML-formatted (numeric) data area.
| Attribute |[Sign||COPY clause|| Value |Error|
[External decimal|[No || 9(4)  |[ABCD|| Yes|
|Externa| decimal”Y% || S9(4) ||$1234 || Y$|

Errorsin sign part - causes of errorsin sign part

When data file conversion involves conversion of external or internal decimal items, the sign part is strictly checked. Before the sign part can be checked,
you must enable the Perform Input Check option when defining layout definition items.

|  Attribute |[Sign|{ COPY clause [Internal representation|| Value | Error |
[External decimal|| No || 9(4) || 31323334 || 1234/|Any digit that isnot 3iserroneous. |
[External decimal|[ Yes|| So4) || 31323354  [[-1234 o _

- Any digit that isnot 4 or 5 is erroneous.
[External decimal|[ Yes|| So4) || 31323344 || 1234
|Interna| decimal || No || 9(4) COMP3 || 01234F || 1234||Any digit that is not F is erroneous. |
[Internal decimal || Y es|[S9(4) COMPS|| 01234C ||+1234

Any digit that isnot C or D is erroneous.

[Internal decimal || Y es|[S9(4) COMP3|| 01234D || -1234

Note: The above external decimal examples assume the ASCII code system. The operational signs for the EBCDIC code system are as follows:
F: Zone bit

C: Positive operational sign

D: Negative operationa sign




Using Data Converter - Record Extraction Function

The record extraction function accepts only the records that satisfy the criteria defined for input file dataitems.
To open the Data Condition Setting screen:

1. In Step 2 of the Conversion Wizard, specify the name of the layout definition file.

N2
Z
‘9
]

2. In Step 2 of the Conversion Wizard, click the Setting button. The Data Condition Setting screen is displayed.



Layout Definition Utility - Invoking

Using the Layout Definition Utility, you can create and edit the layout definition file used by the data file conversion.

Y ou can invoke the Layout Definition Utility in any of the following ways:
- Select Layout Definition from the Start > All Programs menu.
- Start from the Data Converter conversion instruction.

- Openthe LAY OUT.EXE application from Windows Explorer.



Layout Definition Utility - Analyzinga COBOL Library

Although you can enter the whole layout definition yourself, it is generally better to start by having the Layout —>Layout Definition File
Definition Utility analyze an existing COBOL COPY Library. To do this, use the Create from COBOL Library ->COBOL library

function on the File menu. This displays an Open File dialog in which you select the COBOL library to be —>Precautions - Analyzing a COBOL
analyzed. Library

The Layout Definition Utility analyzes the data descriptionsin the COBOL library and automatically populates the
layout for both input and output files. Y ou can then make any edits that are required and save the layout to alayout
definition file.



Layout Definition Utility - Specifying Data Formats

In the Layout Definition Utility, you can specify the data format for the input and the output files. There are three options:
- Datafile

- CSV file
- XML file

Precautions when Changing the Data For mat

If you change the selection between Data File Format, CSV Format and XML Format, previously-defined layout definition information may be lost.

When you convert from CSV Format to Data File you need to input the positions and item lengths for al theitems. It is often easier to re-anayze the
COBOL COPY library than to change the data format.



Layout Definition Utility - Editing Item Information

Using the Item Definition Template ~>Understanding Item Definition
IS eT—————— Information

->Preferences

—>ltem Definition Template

->Advanced Settings
->View Menu

The Item Definition Template is adialog box giving you access to all the basic information for each item. It
does not give access to item extension information, so do not use the template for editing items with
extension information. Even if you do not want to edit the extension information, using the template will
cause the extension information to be lost.

The template is a good way of editing items that do not have extension information. It has the advantage over
direct editing in that it provides you with afull description of each item and drop down lists of attribute
codes. The template also checks your edits for consistency when you click the OK button, and informs you
of any errors so you can immediately correct them.

Invoke the item definition template as the template initializes the advanced settings fields.




Layout Definition Utility - Defining Repeating |tems

The Layout Definition Utility uses the repetition level (Lv) column and the repetitions (Repeat) column to communicate repeating groups of items,

usually defined in COBOL OCCURS clauses.

The Layout Definition Utility only displays elementary items. To indicate that a group of items is repeated, the utility inserts a repetitive definition line
immediately before the repeating group. Thisline only contains alevel number and a repetition count.

The repetition level indicates the level

(Example) Group Item option is" Hidden". See COBOL L ibrary Analysis Options

Data description in COBOL

of nesting of repeating groups. The repetitions column indicates the number of times the group is repeated. The
level number isincremented in the line after the repetition line.
The utility supports up to 7 levels of repetition nesting.

01 ABC-REC.
03 ITEM1 PIC X(10).
03 GROUPL.
05 ITEM2 PIC X(3).
05 ITEM3 PIC X(1).
03 GROUP2 OCCURS 10.
05 ITEM4 PIC X(5).
05 ITEM5 PIC X(5).
05 GROUP2-1 OCCURSS5.
07 ITEM6 PIC 9(2).
05 ITEM7 PICX(2).
03 ITEM8 PIC X(20).

03 ITEM10 PIC X.

03 ITEM9 OCCURS5 PIC X(8).

Layout Definition

Hierarchy | Number of repetitions | Item Name
0 ITEM1
0 ITEM2
0 ITEM3
0 10

1 ITEM4
1 ITEMS
1 5

2 ITEM6
1 ITEM7
0 ITEM8
0 5

1 ITEM9
0 ITEM10




L ayout Definition Utility - Defining Group Items

Specification of agroup item takes the same form as a description of arepeated item, without the specification of the number of repetitions.

The items subordinate to a group item are identified by nesting the subordinate class below the group item definition line. A group item definition line
must consist of only a class and an item name, and the following line must have a subordinate class. The maximum nesting depth of subordinate classes
islimited to seven (7).

In order to display agroup item created from an existing COBOL property on alayout definition screen, the group item must be set up asa"COBOL
Library Analysis Option". Regardless of the setup, editing the group item (adding, deleting, etc.) is possible in the layout definition.

Example:

Data Description in COBOL

01 ABC-REC.
03 ITEM1 PIC X(10).
03 GROUPL.

05 ITEM2 PIC X(3).
05 ITEM3 PIC X(1).
03 GROUP2.

05 ITEM4 PIC X(5).
05 ITEM5 PIC X(5).
05 GROUP2-1.

07 ITEM6 PIC 9(2).
05 ITEM7 PIC X(2).

Layout Definition

Level | Occurs | Item name
0 ITEM1

0 GROUP1
1 ITEM2

1 ITEM3

0 GROUP2
1 ITEM4

1 ITEMS

1 GROUP2-1
2 ITEM6

1 ITEM7




Multi Layout Definition Function

In thismanual, "multi format file" means that the file has various record formats; each record in amulti format file hasits own format. In this section, you will see how to operate a multi
format file using the Multi Layout Definition Function.

By specifying the extraction condition in the Multi Layout Definition Function, you can select specific records to which a created layout definition is applied. Using this function, you
can also extract records from ainput file.

The procedure to make a Multi Layout Definition File
To make amulti layout definition file:

1. Start the Layout Definition
application

Click on the Layout Definition icon to start Layout Definition from the Start menu or Program Manager.

& Fujitsu DataTools V3.0
Fle Edt ‘Wiew Favorites T 2% GF
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= ~

S o

Ed el
DatacConve. .. Layouk

Definition a2

2. Create a new Layout Definition
File

Create anew layout definition file by reading an existing layout file or analyzing an existing COBOL library. After reading or analyzing the existing file, Data Converter creates all of
the item definitionsin the new layout definition file.

tis Untitled - Layout Definition

FIEN Edit Layout Wiew Options Help

Create from COBOL library..,  Ctrl+R %1 i|
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New Ctrl+M
Open... Ctri4+0
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Save As... |
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3. Edit the multi
layout

Specify the comparison imformation in the Layout Definition Template dialog box.

Layout Definition Template &|

Lawout name: iLﬂ\YDLITJ

Condition: EQ - ~ Move layout——
Base point: l‘l_ﬁ Previous I
Length: o = | New | _

biriirriar: i"Tu?m-A-m !

M s ["TO704-B-02"

0k | Cancel Help

4. Add a new
layout




Click on the Add new layout button to add a new layout after the last layout.

tis Untitled - Layout Definition

File Edit Layout Miew Ophions Help

ol || 5|®|c| B|x 8 @l
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|
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4 0] | PRICE | £ |
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5. Insert a new
layout

Click on the Insert new layout button to insert anew layout in front of the displaying layout.

&% Untitled - Layout Definition
File Edit Layout Wiew Options Help

(B[] &[m(e] BxE| wleen vy @
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l me. | Attibute | Sign| Paosiion| Length| Total digis | Decimal | Attbute | Sign | Posttion | Length | Tatal digits| Decimal
1 | DRDERND | 1. 10 | % 1. 10
20 | PRODUCTHO o 110 % 1110
10 | PRODUCTHAME o 2 , | % 212 _
4 0 | PRICE _ [z 41 5 5 [z _ 41 5 5
E o0 | SALESNUMEBER [z 5| 45 4] 4 [z = 45 4 4
E 0 | BALES [z (5| A 3 g [z 5 50 g 9
70 | SALESDATE [z I g B [z & )
50 | CUSTOMERMNAME % 7 40 | % 7 40
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Ready [ A om [

6. Deletea
layout

Click on the Delete layout button to delete the displaying layout.

& Uintitled - Layout Definition

File Edit Lawout Wiew Options Help

ol 8] 3|5 Jo¢|] k
Laypout : iL,&YDUT.g __:j Equal Poz=1: Lenath=10 Cormp "'TO704-L

| Mo 1 Itern Mame: JBDERMO
Input [[_

FRepeat | ltem-name | Attribute | Sign | Position |

| 1T | ORDERNO | H 1
I | PRODUCTNO I il
EEE | PRODUCTNAME | ® |

4 0] | PRICE | £ 4
I | SALESNUMEER |2 [5 | 46
| 6 0] | SALES = [5 | 50
7 0 | SALESDATE = ]
| 5 0] | CUSTOMERNAME | = E7

g 0 | CUSTCODE [ 107

7. Savethe M ulti Layout Definition
File

Select Save as from the file menu to save the multi layout definition file.




S Untitled - Layout Definition
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Layout Definition Dialog Boxes

1. Layout Definition Dialog

Box
Click on the Layout Definition icon to start Layout Definition from the Start menu or Program Manager.
tis Lintitled - Layout Definition
File Edit Layout Miew Ophions Help
Bl || L || & |B|e| B || up|ek|m|| | ©
Layout ; iLQYDUT.1 ‘:J Equal Poz=1: Length=10 Comp "'TO704-4-01" - "T0704-B-02"
Itern Mame: ORDERND
Input [Data format) | Output [Data format]
| | Repeat| ltemname | Attrbute | Sign| Posiion| Length| Total digits | Decimal| atribute | Sign| Position | Len_gth | Total digits | Decimal
| -lil—_——_-—
| o | PRODUCTHO. | = | | |
0 | PRODUCTNAME 3 .21 | _2D_ B .2_1 | .2D_. |
o | PRICE | £ | 1 | a] | Z 41 5] 51
o | SALESNUMBER | £ 15 | 46 4 4 2 5 48 | 4 4.
o | SALES | £ 15 | a0 q] | | Z 5 50 9 9
o | SALESDATE | £ fak} g g | Z A9 8 a
o | CUSTOMERMNAME L EY | a0 L H 67 | 40
o CUSTCODE * 107 10 bt 107 10
Ready [ [ w4
2. Specifying Layout Definition Dialog
Bar
1. List of layout names
Thelist of layout names in the multi layout definition fileis displayed. Select aname from the list to display the layout definition.
2. Control strings of selected layout
The control strings of the selected layout are displayed.
- Format op pos:len comp min-max
op : The operator EQ/NOT/OTHER/NONE is displayed.
pos: The starting position of comparison data is displayed.
len: The length of comparison datais displayed.
min: The minimum value of comparison datais displayed.
max: The maximum value of comparison datais displayed.
Laniaut : iL,e_\._YDUTJ _:j Equal Pogz=1: Length=10 Comp "TO704-4-07" - "TO704-B-02"
3. Layout Definition Template Dialog
2104
1. Layout Name
Specify the layout name, up to 90 bytes. Thislayout name must be different from the existing layout name that is specified in the Basic I nformation dialog box.
2. Condition
Specify the conditiona expression. Thisfield is required. EQ means Equal, NOT means Not Equal, OTHER means Other, and NONE means None.
3. Offset
Specify the offset in records from which comparison of data starts. Thisfield is required. The minimum is 1 and the maximum is 32767.
4. Length
Specify the comparison data length in bytes. Thisfield is required. The minimum is 1 and the maximum is "32767 - base position".
5. Minimum
Specify the minimum value that is to be compared to the record data. Specify a hexadecimal value or a character string enclosed in double quotations. When the specified




valuelength is shorter thanthe  comparison data length specified above, Data Converter inserts NULL in the part of the comparison data that exceeds the minimum value
length. When the specified value length is longer than the comparison data length, Data Converter truncates the part of the minimum data that exceeds the comparison data
length.
If you specify a minimum value and you do not specity a maximum value, Data Converter compares only the minimum value with the input file records.
6. Maximum

Specify the maximum value that is to be compared to the record data. Specify a hexadecimal value or a character string enclosed in double quotations. When the specified
value length is shorter than the comparison data length specified above, Data Converter inserts NULL in the part of comparison data that exceeds the minimum value length.
When the specified value length is longer than the comparison data length, Data Converter truncates the part of the maximum data that exceeds the comparison data length.
If you specify a maximum value and you do not specity a minimum value, Data Converter compares only the maximum value with the input file records.
7. Previous

Click on the Previous button to save the specified conditions and display the previous layout conditions. If the first layout is specified, awarning dialog box will be displayed.
8. Next

Click on the Next button to save the specified conditions and display the next layout conditions. If the final layout is specified, a new layout will be created and displayed.
9. 0K

Click OK to check the specified conditions. If the conditions are valis, they are saved and the window closes. The relationship between Base position/Length and the actual
record length is checked when the layout file is saved.
10. Cancel

Click on the Cancel button to clear the editting conditions and close the window.
11. Help
Click on the Help button to display the online help window.

Layout Definition Template El

Layout narne; ]LAYDLIT.']

Conditian: EQ - [~ Move layout-
Baze point: hﬁ ﬂ]
Length: ]m—:._j_] Met

Mirirnum; ["TOFD4-A-01"

Wi I"TD?‘D4-B-D2"

(] 4 | Cancel Help




Overview of Batch mode

Y ou can run Data Converter in batch mode. In batch mode, the conversion process is executed without user
intervention. If specified, it is possible to execute the process in the background. Data Converter stores the

execution resultsin alog file and sets the command return code. The execution result can be confirmed according
to the return value of the command and the content of the log file event log.

- Conversion Information File

To prepare for executing a conversion in batch mode, create a conversion information file.

Running Data Converter in Batch Mode
- Examining the Log File

->Displaying Conversion Errors
Conversion error information is output to the conversion error file. The conversion error display function usesan | > Preferences

external viewer program to view the output conversion error file (specified by an option: default is Notepad).



Running Data Converter in Batch Mode

Use the following command to execute conversion in batch mode. A message box will indicate an error if an option is not correctly specified.

Command Line Format (items enclosed in brackets[ ] are optional)

Dat aconv. exe [ x| b_Conversion-Information-File-name(*.cif)
[/c Default _Folder name]
[i Input File name]
[0 OQutput File name] }
;? Conversion Error Output File]
/v

Explanation of Parameters

X  Specify aconversion information file. A progressindicator is displayed during execution.
Click the Stop button on the progress indicator to stop the processing.

b  Specify aconversion information file name. If specified, no progress indicator window is displayed.
¢ Specify adefault folder name.

i Specify aninput file name.

0 Specify an output file name.

e Specify aconversion error output file name.

f  Select forced overwrite mode

v Specify when outputting to an event log instead of the log file.

Notes:

- Either x or b must be specified, but not both.
- Specifying ¢, i, 0, or ewill override any corresponding folder/file name specified in the conversion information file.
- Any of thec, i, 0, and e parameters can be omitted. In this case, the contents of the conversion information file will be used instead.

- If awildcard is specified for the i parameter, the character string specified for the o parameter is assumed to be an extension. The file name whose
extension is replaced with the above extension is set as the output file name.

- A wildcard can be specified for the i parameter.

- If thefile specified by the o parameter already exists, and the f parameter is specified, any existing output file will be overwritten. If the f parameter is
not specified, processing will stop.

Note: File names that include blank characters must be enclosed in double quotation marks.

Return Values
Execution ends with one of the following return values.
Note: A correct return value cannot be guaranteed when a process is abnormally terminated.

0 Normal termination without conversion errors
1 Normal termination with conversion errors
2 Abnormal termination due to log file access errors

3 Abnormal termination with description or errors output to log files



Examining the Log File

The Log Fileisatext file created by Data Converter to record the results of executing in batch mode. It iswritten | > Preferences
to the file name and folder specified in Preferences.

If alog file of the specified name already exists, then new log entries are appended to it. If it does not exist, a new
fileis created.

Entries are written to the log file for both normal and abnormal termination.

Example of a L og File (DataConv.log)

2001/08/12 17/17/02[datal.cif] Starts the conversion process.
2001/08/12 17/17/04[datal.cif] Conversion successful. Number of input records: 14 Number of output records: 14 Number of errors:
2

2001/08/21 22/06/30[xdatal.cif] Starts the conversion process.
2001/08/21 22/06/30[xdatal.cif] File not found. File'Data2.dat' Call:CreateFile,Error: 2




Linking from Data Editor

Y ou can invoke Data Converter from Data Editor.

Actionswithin Data
Editor

1 Openthedatafile.

2 Apply any required edits. Note that deleted items are also passed to Data Converter.

3 Usethe Select Items function if you only want to use data from selected fields.

4 From the Options menu select Link to Data Converter.

5 Select the output data format and choice of all or selected itemsin the Link to Data Converter dialog box.

6 Click on Data Converter.

>> Data Converter creates the necessary files, such as the converter information file and input file, as temporary files = Conversion Information File

in the Data Editor work file folder. —>Layout Definition File
Actionswithin Data
Converter
1 Confirm the output file name and code system. - Conversion Wizard Step 4

2 Select the desired output file format, and enter or adjust other information as appropriate.

3 Click Next to confirm or change details as required.

4 Click Finish. Data Converter displays the conversion information in its main window.

5 Click the Convert button to convert the data.

6 Note the name of the output file (format is LINNnnn.OUT, where nnnn is an arbitrary string of characters).

7 Close Data Converter. Data Converter deletes the temporary files containing the input data, conversion information
and layout definition.

Precautions
When Data Converter isinvoked from Data Editor the File menu functions are not available.

Theinformation file and layout file are deleted when Data Converter is closed. To re-execute the conversion, you need to re-start the processin Data
Editor.



Command Button

Button Name Explanation

Conversion Wizard Sets or updates conversion information viathe Conversion Wizard. - Understanding Data Converter

Preview Confirms the conversion result on the screen beforehand. The preview ->Previewing Conversion Results
function cannot be used on an output file unlessit isagenera file.

Convert Starts the conversion processing.

Display Errors Displays the content of the error files generated by the conversion ->Displaying Conversion Results

processing, if aconversion error file exists.



Basic Information
Field Explanation
Work Folder Specify the name and location of the Work Folder.
By default, the system's Work Folder is used (specified in the environment variable TEMP).
Log Filefor Batch Execution Specify the full path for the Log File that is output when executing in Batch mode.
The default isto create the file DATACONV.LOG in the Work Folder.

Program for Displaying Conversion Errors

The external viewer program which displays the conversion error is specified by afull path name. Notepad or other text
editors can also be specified.

Notepad is used by default.
COBOL
Option Explanation
Allow COBOL filesto exceed 1GB

Specify thisitem when you treat a COBOL file (sequential or line sequential files) that exceeds 1 GB.
Lengths specify number of Bytes

Select when using binary byte type in binary items.
Use COBOL specifications on binary files

Specify whether to use COBOL specifications on binary files when the code system is Unicode.

- When this box is checked, alphanumeric and national items will be treated as UCS2.

When this box is unchecked, alphanumeric items will be treated as UTF-8, and national items will be treated as
ucs2.

When this check box is selected, data compatible with V3L 40 and earlier versions will be output.
This box is checked as the defaullt.



Conversion Wizard Step 1 - Common I nformation

Menu Function Explanation
Select File Conversion Mode Select Data File Conversion or Text Conversion for the file conversion mode. —>DataFile Conversion
- Text Conversion

If you specify a default folder, you can set up each file name by using arelative

path name.
If you use a conversion information file at alater date and the files have been
moved to another folder, you need only change the default folder name. The other

relative file names will be still be valid.

Default Folder



Conversion Wizard Step 2 - Layout Definition File Information

Menu Function Explanation

Specify Layout Definition File Specify alayout definition file name to be used when converting a data file.
Update Layout Definition File Activate the Layout Definition Utility.

Create new Layout Definition File from library Specify an existing COBOL library to create alayout definition file.

Select Input Record Use the Data Condition Setting dialog to select the input records.

A Layout Definition File can be created in any of the following three ways:

- Activate the Layout Definition Utility to create a new layout definition file from an existing COBOL library.
- Click the Analyze button of the Conversion Wizard to create a new layout definition file from an existing COBOL library.
- Activate the Layout Definition Utility to manually enter all item definitions.

Note: Conversion Wizard does not display this page for Text Conver sion mode.



Input Record Selection Conditions Dialog

Use this screen to specify data conditions for the records to be extracted from the input file. Only the records that satisfy the specified data conditions will

be output.

For record extraction specifications, see Record Extraction in Extraction Specifications.
For notes, see Notes on Record Extraction Function.

Iltem

Add

Update

Delete

Condition List

Condition Connector

Item Name

Operator

Hexadecimal (e.g. FOF5)

Condition Value

Output Unmatched Records
Unmatched Record File

Explanation

To add an extraction condition, specify Item Name, Operator (hexadecimal form), and Condition value within the
conditions group (Condition Connector must also be specified for the second and subsequent conditions), and then click
the Add button. The extraction condition is added to the Specified Conditions List.

If an error occurs, correct the condition according to the error message.

To modify an extraction condition, select the condition you want to modify from the Specified Conditions List, specify
Item Name, Operator (hexadecimal form), and Condition value within the conditions group (Condition Connector must

also be specified for the second and subsequent conditions), and then click the Update button. The extraction condition is
updated on the Specified Conditions List.

If an error occurs, correct the condition according to the error message.

To delete an extraction condition, select the condition you want to delete from the Specified Conditions List, and then
click the Delete button. The extraction condition is deleted from the Condition List.

The specified data conditions are listed. Record extraction will be performed based on the conditions listed here.

No. Indicates the sequence number of the data condition.

The specified data conditions are applied in ascending order of the sequence number, from 1 to 10.
Connected Indicates the concatenator AND or OR for the data condition, for the second and subsequent
Condition conditions.
Item Name Indicates the item name for the data condition.
Operator Indicates the operator for the data condition.

Condition Value Indicates the condition value for the data condition.

Hexadecimal YESisdisplayed if Hexadecimal form is selected.
(e.g. FOF5)

If you specify two or more data conditions, select AND or OR as the concatenator between the first condition and the
subsequent condition. Noinitial valueis set.

Specify the item name in the layout definition file that you have specified in Step 2 of the Conversion Wizard. Y ou cannot
specify group items or variable-occurrence items.

Specify the operator to be used to compare the datain the input file with the condition value. The specifiable operators
vary depending on the data attribute:

Character type . . -
attribute String Equals, Prefix Match, !=
Numeric type 0= > = < <=

attribute o

Check this check box if you want to specify the condition value in hexadecimal. This checkbox is available only for the
character type attribute.

Specify the condition value to be used to extract data records from the input file.

The maximum length of condition value specificationsis 150 bytes.

For the numeric type attribute, a number consisting of up to 18 digits (+, -, and . (decimal point) are not included) can be
specified.

If no condition value is entered, Data Converter considers that NULL datais specified. Y ou can only omit the condition
value when the data attribute is the character string item (M).

*Null condition value can be used for NULL data extraction for CSV/XML-formatted character string items.

To specify a condition value when Hexadecimal form is selected:
Available characters are single-byte alphanumeric characters0to 9, A to F, and ato f, and semicolons (;).

Semicolons must be used after the end of abyte. If a semicolon isinserted between bits of a byte, Data Converter omits 0
(hexadecimal) for the low-order hit.

Check this checkbox if you want to output records that do not satisfy the data conditions.

Specify the name of the file to output unextracted records.
If there is any input record that does not satisfy the record extraction condition, it is output to thisfile. Since the

unextracted records file contains the data that is yet to be converted by Data Converter, it can be used as the input file for
record re-extraction.



Conversion Wizard Steps 3 and 4 - | nput/Output File Information Setup

Menu Function Explanation
Encoding Select the code system of the file being converted. - Conversion Rules - Character Code
File Name Specify an input or output file name using afull pathname. If you have set a
default folder, you can also use arélative pathname.
File Type (Data Format) (for Data File Conversion) —>Binary or Text file

Specify aBinary or Text fileor aCOBOL File. Specify Binary or Text filefor ->COBOL File
anything other than a COBOL File on Windows.

Key Information (Data Format)  (to Output a COBOL Index File) —>1ndex Key Information
Specify an index key.
Setup (CSV Format) (for aCSV-format File) ->CSV Information Setup
Specify aCSV format.
XML Information Setup (for an XML-format File) 2> XML Information Setup
Specify an XML format.
Specify Unicode Attributes (for Unicode) "Endian
Specify information on Unicode. "Byte Order Marker
Input
filetype
Binary | Binary COBOL
Item Value | 1, ext| O or COBOL Line COBOL | COBOL XML
file Text | Text | Sequentia | Sequentia | Relative | Index | CSV «5
file | file file file file file
*1 *2 *3
ucs2 N
Encoding Y N Y N N N N Y
UTF8 Y
Big
Endianness Y Y Y Y N Y Y Y N
Little
Output
filetype
Binary | Binary COBOL
Item Vaue | 1, ext| O or COBOL Line COBOL | COBOL XML
file Text | Text | Sequentia | Sequentia | Relative | Index | CSV 6
file | file file file file file
*1 *2 *4
ucs2 N
Encoding Y N Y N Y N N Y
UTF8 Y
Big
Endianness Y Y Y Y N Y Y Y N
Little
Omit Signature Y N N N N N N Y Y
Y : usable
N : disabled
*1 This specification is handled as COBOL specification. (**)
*2 This specification depends on the selected code system. (**)
*3 When theinput isaLine Sequentidl file, it follows the Signature.
*4 When the output is Line Sequential file, endian cannot be specified, and
the output is set to little endian.
(specification of COBOL)
*5 The encoding form is given priority when the input is specified as XML.
*6 Specify whether to omit the output of the Signature.
(**)Refer to "Use COBOL specifications on binary files" in Options for
details.

Omit Unicode Byte Order Marker Specify whether to omit the output of the Unicode byte order marker (BOM).
Check this box only if you wish to suppress output of the Unicode byte order

Unicode Byte Order Marker

marker.
(This option is only enabled when either the input or output file specification is
Unicode.)

Specify Record Attributes Specify information on arecord. In general, specify information as follows:

Type of File Attributes New Line Code




No (Record length is the same

Fixed length data file format | Fixed length asin the layout definition)

Windows/DOS CSV format | Variablelength | New line code (CR+LF)

Windows/DOS text Variable length | New line code (CR+LF)
UNIX text and CSV Variablelength | New line code (LF)

Mainframe source Fixed length No (Record length: 80)
XML format Variable length | New line code (CR+LF)

Wildcard Specification

If awildcard is used to specify an input file, the wildcard is asumed to apply to the filename only. The input file name extension will be replaced by the
extension set for the output file name. (See exception for XML format below.)

Input file nane item : *.dat
Qutput file name item : .out

Retrieved file nanes : aaa. dat, bbb. dat
Qut put file nane : aaa.out, bbb.out

About wildcard options when editing an XML format

When theinput fileisin XML format ->Precautions - Conversion of XML Files

Input file name item : *.xm
Qutput file nanme item : aaa.dat

anes : aaa.xm, bbb.xmn

Re len
Qu nane . aaa. dat

— —

ri
pu

When the output sideisin XML format

Input file name item : aaa.dat

Qutput file name item : *.xnl

Input file nane . aaa. dat

Qutput file name : aaa00000. xm , aaa00001.xm , aaa00002. xm

- Specifying awildcard as an input file name sets the default file name as Dataconv.err.

All retrieved input file errors are output to an error file in the addition mode.

- If an error file already exists, the existing file is deleted and anew fileis created.

- The same layout definition fileis used.
If an output file already exists, a message box appears asking if the output file is to be overwritten.

- In batch mode, processing is terminated if an output file already exists.
- Specifying the /f option causes an existing output file to be overwritten.




Conversion Wizard Step 5 - Other Information (Error, User Defined Conversion Table)

Convert rule
Item

Don't convert if input and output encodings are
the same

Specify User Defined Conversion Table
Item
File Name

Specify Error File Information
Item
File Name

Conversion Error Limit

Continue when # of errors exceeds limit

Continue Rule

1 byte error substitution code

Explanation

If the input encoding is the same as the output encoding, the conversion
is not done and the input data is output directly.

Explanation

If required, enter the name of a user defined conversion table file that ->Creating User Defined
specifies the code conversion to be used. Conversion Table
Explanation

Enter the full path name of a conversion error file. Relative path names > Conversion Error File
can be used if a default folder is set. The error file extension defaultsto
.ERR.

Specify the maximum number of error messages to be written to the
conversion error file, from 1 to 3000. The default is 100.

When this box is checked, Data Converter runs the conversion to the end, - Overview of Batch Mode
regardless of the number of errors.

When this box is not checked, Data Converter displays adialog box in

batch mode or when the limit is reached. Data Converter aborts the

conversion without displaying a message.

If the maximum number of errors that can be output is exceeded during

the conversion process, select to continue the conversion process with or

without issuing a conversion error.

When Data Converter encounters an unsupported character code in the
input file, it outputs the character specified in the field.
Specify the value using two hexadecimal digits.

If no character is specified in thisfield, " _" (underscore) is output.



Layout Definition Utility - Under standing I tem Definition I nformation

The table below lists all the information that the Layout Definition Utility handles for each item. Item Extension ->_Advanced Settings
Information isindicated by an asterisk "*" “>View Menu
A number of the labels for the information columns are truncated in the display. Note that the utility displays the full
label and contents of the cell in focusin arow above the column headings.
Select Extended Display on the View menu to display the extension information.
Field M eaning
Lv Displays the repetition levels of 0-7. Note that the repetition levels are different from the COBOL - _Defining repeating items
data description level numbers. Refer to Defining repeating items for afull description of repetition
levels.
Directly editsthe .
cheet Level: From0To 7
Repeat Displays the number of repetitions. Lines with repetition counts only have the repetition level and
(OCCURYS) repetition count. Refer to Defining repeating items for afull description.
Directly editsthe y
heet. OCCURS: From 2 To 32767
Item-name An arbitrary name is assigned if no entry is made.
Attributes Displays the attributes of the item. Attributes are divided into character and numeric types. You - _Attribute Description
cannot convert between character and numeric attributes.
Sign (For numeric items)
Sisdisplayed when the sign format of an external decimal item is shown. - _External Decimal Sign Type
Directly edits ~ WithaSign: S
the sheet A specified value is different in case of an externa decimal, depending on the
attribute. Please refer to External Decimal Sign Type for details.
Position For datafile format.
Displays the offset of the item within the record. The position numbers start at 1.
Length Displaysthe length of theitem in bytes. Thisisalways an even number for National characters.
Not needed for CSV format files.
Total Digits For numeric attribute itemsin data file format.

Displays the total number of digits for numeric items. Thetota digits figureis the sum of the number
of digitsin the integer part and the number of digitsin the decimal part.

Decimal For numeric attribute items in data file format.
Displays the number of digits after the decimal point.

Quotes(*) Specifies that Input CSV-formatted items are separated by quotation marks.
Specifies that Output CSV-formatted items are to be created using quotation marks as separators.

Y isdisplayed for items that have quotes. By default, character type items are enclosed in quotes, and
numeric type items are not in quotes.

Directly editsthe

Enclose in quotation marks. Y
sheet q

Input Check(*) Performs an input check.

Y isdisplayed for input data that will be checked for a match with the item attributes. This does not
affect the output file - it only affects the messages that are written to the error file.

Directly editsthe
sheet

No Conversion(*) Output data without converting it.

Perform input check: Y

Y isdisplayed next to items to be output as-is, with no conversion.

Directly editsthe
sheet

Fixed Output(*)  Output fixed length data.

Output data without converting: Y

Y isdisplayed for items to be output according to the length specified. Thelength istreated as0
when no output area length is specified.
The item is the output side variable-length (When the output is CSV format, include). When the



Zero Suppress(*)

Null(*)

Tag(*)

output has a numeric character string attribute (V), the number of whole digits and number of fraction
part digits specifications are applied.
If this specification is applied to al items, the output file becomes the length of afixed record.
Directly editsthe Output fixed length data: Y
sheet Item length: Specifies the length in bytes of each output dataitem.
Valid for numeric character strings with fixed output.
Enable suppression of zeros.

In the numeric character string attribute (V) of the fixed output specification, neither leading zeros
nor the fraction part subordinate to position O are suppressed. When 'Y isdisplayed, zeros are
suppressed and blanks are output.

Directly editsthe
sheet

No conversion error generated when input dataiis null.

Enable suppression of zeros: Y

When the data file format has an al phanumeric character item attribute and the input datais all null
code (0x00), the null code usually causes a conversion error and excludes the character. When | is
specified, no conversion error is generated, and the initial value of the output side item attribute is

output.

Directly editsthe
sheet

(for XML format)

Nothing is displayed in the Tag column when the item nameis output asa start/end tag. A is
displayed when it isto be output as an attribute. E is displayed when the item name s to be output as
an EMPTY tag. N isdisplayed when the item name is not allowed to be output as a tag/attribute.

Directly edits the sheet Start/End Tag: (blank)
Attribute: A
EMPTY Tag: E
None: N

No error if null data: |



Layout definition Utility - Attribute Description

Items are divided into character and numeric types. CSV format and XML format files can contain only M and V attributes. —~>Endian
An asterisk "*" in the meaning column marks the attributes in which the internal format differs according to the Endian of the supporting
system.

The sign column shows a set value when the edit isinput directly.

Type Display Common Description Meaning
char
Character X Alphanumeric character String of 1 byte characters.
N National character String of 2 bytes characters.
M Character string String of character.
Mixed char
C char type Character string terminated by a null byte.
R Variable length string Character string with date length in the first 2 bytes.(*) The support code systemis
ASCII, Unicode.
numeric z External decimal COBOL numeric Display format
P Internal decimal COBOL packed decimal format
B Binary COBOL bhinary format
5 COMP-5 COBOL binary format(*)
S short type 16bit binary(*)
L long type 32bit binary(*)
\% Numeric string Numeric in character form (signs and the decimal point are included as characters).

Other - No character Used for addition or deletion of items.



Layout Definition Utility - Item Definition

Y ou can define the information for each item using the I1tem Definition. ->Understanding Item Definition Information

—>Advanced Settings
Refer to Understanding Item Definition Information for the meaning of each item.

Changing thelineto be edited

The layout definition line to be edited can be changed using the buttons Top, Previous, Next, and Bottom.
Clicking the Next button when the final line is selected will create anew line.

Defining Group Item

To clear arelative position, the area length, the number of whole digits, and the number of fraction part
digits 0, select the blank line at the end of the Input Information/ Output Information Attribute combo

box, and click OK. When defining agroup item, it is recommended to not correct an existing item, but
instead create anew line using lineinsertion and line addition.

Automatic Update of Positions

When you change the length of an item, you affect the positions of all following itemsin the record. The
Layout Definition Utility prompts you when you change item lengths, asking whether you want the
positions updated automatically. If the positions are not updated automatically, you must edit them
manually. The automatic update function does not update repetition levels and numbers of repetitions.
Also, it cannot be used when an item whose length has been changed has a repetition level greater than 1.
The automatic change function cannot be used to change the hierarchy or the number of repetitions.

Effective range of Cancel button

Only the item currently being edited is affected by the Cancel button. Changes made using the T op,
Previous, Next, or Bottom button cannot be cancelled.



Layout Definition - Layout Definition Template

Y ou can specify the conditions of the multi format file layout with the Layout Definition. Layout Definition Information
For more information about each condition, please refer to the Layout Definition Information dialog box.
Changing the layout definition to be edited

The layout definition to be edited can be changed by clicking on Next or Previous. Clicking the Next button when the
final layout is selected will create a new layout.

Effect of Cancel button

Only the layout information currently being edited is affected by the Cancel button. If layout information was changed
using the Next or Previous button, the changes cannot be cancelled.



Layout Definition Utility - Advanced Settings

Specify advanced settings for theitem. Display this dialog box by clicking the Advanced... buttoninthe = —->Item Definition
Item Definition dialog box.

->Understanding Item Definition Information



L ayout Definition Utility - Special File Encoding

Specia file encoding information can be specified in the layout definition file.

Item Explanation
Layout Specify the layout name. (Treated as a comment.)
Record Specify the record name. The record name is used for the root tag of XML (DTD) files, or the O1 level item

of aCOPY library.
The following items select a set of objects on the input side and each object on the output side.
Item Explanation See Also
Add NULL display area

If selected, inserts a 2 byte null display areain front of each item. The actual item becomes 2 byteslonger > Null display Area
than the length in [tem Infor mation. - 1tem Definition Information

When you change this selection, you must also change the positions of each item. The All Itemsfunction =~ > Operations on All Items
can be used to update the positions.

Treat binary as big endian.
Specifies the endian of binary numeric on data. Selecting thisitem affects the following: ~>Endian

- Internal display of COMP-5, short, and long items.
- The datalength added to variable length items (attributes R and Y)

It is recommended that you check this when you are targeting SPARC machines.
Treat NULL asinput string terminator. (Used when the input is a data file format.)
Enable this option when anull in the input datais to be treated as a character string end.



Layout Definition Utility - Data Format

Y ou need to select which of three data formats apply to the input and output files.
The three formats are:

- DataFile

- CSV File

- XML File

Precaution on Changing the Data For mat

When you change the data format of an input or output file associated with an existing layout definition file, the information in the layout file is no longer
valid. Moreover, when you change from CSV or XML format to data file format, it is necessary to define arelative position and area length for all
items. When you change the data format, it is recommended that you reconfirm the definition of the file from the COPY library.



Layout Definition Utility - Operationson All Items

Settings can be made for al items at the same time.

Item

Operations menu

Target

Explanation

Explanation

Select afunction from the list.
See the descriptionsin the explanation box for the details of each function.

Select whether the target of the function is the input definition, the output definition, or both.
Input/Output selections are disabled according to what is appropriate for the function.

Displays each function of a setup menu.



L ayout Definition Utility - COBOL Library Analysisoption

Specify the required information to analyze a COBOL library.

Items with (*) are default settings at first-time startup.

Menu Function

Explanation

AnalysisMethod Specify the analysis method.

Analysis Options

Item

Explanation

COBOL analysislibrary(*)

Analyzesfilesusing COBOL analysislibrary.

Fujitsu NetCOBOL compiler

Analyzesfilesusing FUJ TSU NetCOBOL compiler.
Fujitsu NetCOBOL must beinstalled to use this option.

Specify other analyzing information.

Item Explanation

Reference Format | Fixed Specify the format of the COBOL library.
Variable(*)
Free

BINARY Option | WORD(*) | Indicate how binary items are to be handled. If this option is checked, binary items will be
BV TE handled at abyte level. If this option is not checked, binary items will be handled at the word

level. For unsigned binary items, the handling of the leftmost bit can also be specified:
BINARY (WORD,MLBON): The leftmost bit is the sign bit.
BINARY (WORD,MLBOFF): The leftmost bit is a number.

Fujitsu NetCOBOL must be installed to use this option.

clause

Additional COPY sentence

If the copy sentence does not specify the REPLACING phrase when the COBOL source
contains atemporary origina (parentheses etc.), the analysis may fail. To analyzeit correctly,
add a COPY sentence clause here, using COBOL grammar. The specification of the
JOINING/DISIOINING phrase is also permitted.

Example:

REPLACING ==()== BY ==AA==

This option isonly available when COBOL Library is specified for afile type.

Group Item Option

Show(*)

Hide

Displays group items on the layout definition as the result of analysis. The item name of the
group item and the repetition definition is displayed.

Does not display group items as the result of analysis on the layout definition.  This option
specifies the same display as the layout definition of versions before V3L 31.




Conversion Rules - Character Code

The following table shows the input and output Character Code combinations supported by Data Converter.

Input/Output | ASCII | EBCDIC | Unicode | Latinl | Code Page
ASCII Y Y Y N N
EBCDIC Y Y Y N N
Unicode Y Y N Y Y
Latinl N N Y Y Y
Code Page N N Y Y Y

Y : usable

N : disabled

Adjustments to the standard conversions can be made using user-defined conversion tables.

When converting character fields (for example fields with attribute X), Data Converter checks that the characters are valid. These checks are performed
regardless of whether the input and output code systems are different. Data Converter reports conversion errors when non-character codes are found in
input character fields. ASCII tab characters (0x09), and EBCDIC values 0x28 and 0x29, do not cause errors.

Y ou can switch off the code checking for afield by specifying "Y" in the "No Conversion" extension information in the Layout Definition utility.

The following table shows the input and output file format combinations supported by Data Converter.

Input/Output | Binary file | COBOL file | CSV file | XML file | Text file
Binary file Y Y Y Y N
COBOL file Y Y Y Y N
CsV file Y Y N Y N
XML file Y Y Y Y N
Text file N N N N Y

Y : usable

N : disabled

The following table shows the code systems that are supported for each file format in Data Converter.

format/code | ASCII {EBCDIC |UCS2 | UTF8 | Latinl | Code Page
Binary file Y Y Y Y Y Y
COBOL file| Y Y z z Y Y
CsV file Y N Y Y Y Y
XML file Y N N Y Y N
Text file Y Y Y Y Y Y

Y : usable

Z : storesby X item (UTF8 form) and N item (UCS2 form).
N : disabled



Conversion Rules- COPY Sentence Clasue

Size Errorswhen Converting COPY Sentence Clauses

Data Converter ignores trailing spaces when reporting size errors for COPY sentence conversions. Data Converter only reports a size error if the COPY
sentence that remains, after the trailing spaces are removed, istoo large for the target field.

For CSV files, asize error isreported only if the COPY sentence length is greater than the maximum allowed.

Treatment of NULL (0x00) and extended ASCII code

Low-valueisaconversion error because Data Converter does not consider 0x00 and extended ASCII code (0x80-0xFF) to be a character string. For low-
value data, use the User Defined Conversion Tables (.CNV) asfollows.

Example of User Defined Conversion Tables:

#ASCI ASCI
00:00

#ASCI EBCD
00:00



Conversion Rules- Numeric Items
Signsin CSV Format, XML Format

CSV Output Filesand XML Output Files

Numeric items (attribute V) with asign (Sin the sign column) have "+" or "-" placed at the beginning of the item, depending on the sign of the input
item.

CSV Input Filesand XML Input Files

Data Converter checks for "+" and "-" signs at the beginning and end of the field, and sets the sign of the output number accordingly. If thereisno sign
character, the output is set to "+".

Values Output when Numeric Errorsare Detected

Numeric errors occur when input numeric items contain invalid values.

When the output numeric field contains characters (types Z and V), Data Converter will read the lower 4 bits and output a decimal digit based on that

value (mod 10) (i.e. the remainder when the valueis divided by 10). For example, if the input field contains A (0x41), the output isthe digit 1; if the
input isL (Ox4c), the output digit is 2 (OxC divided by ten leaves aremainder of 2).

For all other output numeric types, Data Converter outputs zero when the input dataisinvalid.

Digit SizeErrors

Data Converter reports digit size errorsif there are insufficient digits in the integer part of the output number to keep the digits from the input number.



Extraction Specifications - Record Extraction

Specifications for record extraction are explained below.

- Conversion of conditional value's character code (for character type attribute data)

- Numeric value conversion for comparison against conditional value (for numeric type attribute data)
- Supplement: Rules applied when multiple data conditions are specified

For notes on extraction specifications, see Notes on Record Extraction Function.

Conversion of conditional value's character code (for character type attribute data)

When records are extracted on the condition represented by data with a character type attribute, Data Converter first converts the character code of the
conditional value specified on the Set Data Conditions dialog box to the input file's character code system, and then compares the datain the input file

against the conditional value. Code conversion of the conditional value is performed based on the following rules. If the input file's code system is Shift
JIS, or if Hexadecimal Specification is selected, code conversion will not be performed.

* Code conversion from Shift JIS to the input file's code system is performed.

Input file's code system

Conversion

ASCI| Code conversion not performed. The data specified for the conditional value

will be used.
EBCDIC

ASCII to EBCDIC

Unicode (UCS2/UTF8)

ASCII to Unicode

After character code conversion, extraction rules are applied based on the operator specification. Extraction rules are explained below.

Alphanumeric character or character string (CSV/XML) items

String Equals The dataitem in the input file will be evaluated as a "string equals’ when its area length and value match the area length
and value of the conditional value.
Prefix Match The dataitem in the input file will be evaluated as a"prefix match" when the part of the conditional value that fits within
the conditional value area length matches the value of the dataitem in the input file.
CHAR-type items
String Equals

The dataitem in the input file (not including the NULL character that indicates the end of the character string) will be
evaluated as a"string equals’ when its area length and value match the area length and value of the conditional value.

Prefix Match The dataitem in the input file will be evaluated as a "prefix mathc" when the part of the conditional value that fits within

the conditional value arealength matches the value of the dataitem in the input file.

Variable-length character string items

String Equals The dataitem in the input file (including only the part that fits within the valid arealength in RDW) will be evaluated as

a"string equals' when its area length and value match the arealength and value of the conditional value.
Prefix Match

The dataitem in the input file will be evaluated as a "prefix match” when the part of the conditional value that fits within

the conditional value area length matches the value of the dataitem in the input file.
Variable-length national items

String Equals The dataitem in the input file (including only the part that corresponds to the number of charactersin RDW) will be
evaluated as a "string equals' when its area length and value match the arealength and value of the conditional value.
* For the datain the UTF8 format, RDW will be included in the area length.

Prefix Match

The dataitem in the input file will be evaluated as a "prefix match" when the part of the conditional value that fits within
the conditional value arealength matches the value of the dataitem in the input file.

Numeric value conversion for comparison against conditional value (for numeric-type attribute data)

When records are extracted using the data with the numeric type attribute as the condition, Data Converter converts the numeric datain the input fileto a

format (numeric value) that allows comparison with the conditional value specified in the Set Data Conditions dialog box before comparing the datain
theinput file against the conditional value. Conversion to numeric valuesis performed based on the following rules.

After numeric value conversion, extraction evaluation is performed based on the operator specification and then the records are extracted.
Unsigned attributes

Always treated as a positive value.
Signed attributes

Treated as a negative value if aminus sign is detected or as a positive value otherwise.
External or internal decimal

- Non-numeric datais contained in a numeric part.
Conditions making CSV/XML format
dataitemsineligible

- Data other than the plus/minus sign, decimal point, or numbersis contained.




for extraction

- Data having 19 or more significant digitsis contained.
- A plusminus sign is detected at a place other than the beginning of the area or more than one

decimal point is detected.

Supplement: evaluation rules used when multiple data conditions ar e specified

The example below shows how evaluation is performed when two or more data conditions are specified.
Data condition setting example:

No. Coggit;r:%ir:)n Item Name Operator Conditional Value :gg:?g;?gln
1 -- Product name String Equals Bar code reader
2 OR Product name Prefix Match High-speed
3 OR Unit price > 10000
4 AND Unit price <= 90000
5 OR Customer name Prefix Match 8FAC97D1 YES
6 OR Customer name Prefix Match 8E52;89BA YES

Data condition evaluation order
1. No. 1 data condition is evaluated.
. No. 2 data condition is evaluated.
. No. 1 and No. 2 data condition evaluation results are OR'ed together.
. No. 3 data condition is evaluated.
. The result of step 3 above is OR'ed with the result of No. 3 data condition evaluation.
. No. 4 data condition is evaluated.
. Theresult of step 5 above is AND'ed with the result of No. 4 data condition evaluation.
. No. 5 data condition is evaluated.
. Theresult of step 7 above is OR'ed with the result of No. 5 data condition evaluation.
. No. 6 data condition is evaluated.

. The result of step 9 above is OR'ed with the result of No. 6 data condition evaluation.
Thisisthefinal data condition for record extraction.

© 0 N o o~ WD
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The above sequence can be represented by aformula as follows:

(((((product name = bar code reader) OR (product name » high speed)) OR (unit price > 10000)) AND (unit price £ 90000)) OR (customer name
» 8FAC97D1)) OR (customer name » 8E52;89BA)



Precautions - Data Limits and Unsupported File Formats

Data Size Limits

Item Value Remarks

Maximum record length 32767 bytes

Minimum record length 1 byte

Maximum number of itemsin arecord 3000

Maximum length of character dataitems 32767 bytes

Maximum number of digitsin numeric items 18 digits Includes fractional part of the number.
Maximum levels of nesting in OCCURS clause 7

Maximum number of itemsin a COPY library 3000 Includes group items.

Maximum length of item name 60 bytes

Maximum number of errors that can be output 9999

Maximum number of XML files that can be output 100000 Differs according to the file system.
Maximum log file size 4 Gbytes

Maximum COBOL |/O filesize

The size of the COBOL 1/O file that can be processed depends on COBOL and the COBOL runtime system that uses it.
Unsupported File Formats

- Variable length files from mainframe or mini computers (general file)

- Fileswith multiple record formats (multi-format)



Precautions - Conversion | nformation File

The content described in Understanding Data Converter can be preserved as a Conversion Information File, but the following precaution exists.

- Data Converter stores full path names for the Layout Definition, Input and Output files in the Conversion Information File. For example, if the layout
definition file named when the conversion instructions are saved does not exist or has been moved, an error will occur when the conversion instruction
fileis opened.



Precautions - Handling COBOL Files

Take the following precautions when using COBOL files .

- Data Converter does not take exclusive control of COBOL files. Therefore do not update the input files from other applications while running Data
Converter.

- Data Converter reports an error and aborts the conversion processif duplicate key values are found for output indexed files defined without duplicates
allowed.

- Data Converter picks up the organization, record attributes and record lengths from the header records of COBOL indexed files. If the information

from the file does not match the information defined in the Conversion Information File, Data Converter ignores the Conversion Information File and
continues with the conversion.



Precautions - Analyzing COBOL library

- Theanalysis expects correct COBOL syntax. Incorrect syntax may produce unpredictable results.

- The maximum number of itemsin the library, including group items, is 3,000. If alibrary contains more than 3,000 items you need to reduce the
number of items by combining items containing details that are not significant to the conversion (for example, adjacent character items could be
combined into asingle item).

- The COPY library should start with an O1 level item.
- When there are multiple O1 level items, only thefirst O1 level item is analyzed.
- Analysis does not support the following features. Y ou need to edit these out of the COPY library.

- Items having level numbers other than 01-49.
- SYNCHRONIZED (SYNC) clause.
- OCCURS DEPENDING ON clause.

- Anaysisignores REDEFINES items. Only the redefined item descriptions are used.
- Anaysisinterprets the following descriptions as numeric items:
Pointer items, Boolean item, Index items, Floating point items
- Numeric edited items and alphanumeric edited items are interpreted as a phanumeric item attributes.
- Analysisignores the following clauses:

KEY IS, INDEXED BY, JUSTIFIED, BLANK, VALUE, CHARACTER TYPE, PRINTING POSITION, BASED ON

Direct Input of Layout definition
- Correct operation cannot be guaranteed if an item name contains trailing blank spaces.



Precautions - Preview function

- Preview does not work on COBOL structured filesi.e. those files with sequential, relative or indexed organizations.

- Preview can only interpret ASCII character values. If the output fileisin acharacter code other than ASCII, you need to preview the valuesin
hexadecimal.

- Preview uses only Courier New font.
- Non-character codes, other than new line character, are displayed as"." (period).

- The Preview function displays up to 100 records, starting with the first record in thefile.



Precautions - Display Conversion Errors

The Precautions of the Displaying Conversion Errors function are as follows.

- Thefunctionisonly enabled if the conversion error file exists.

- The program for viewing the conversion error file is activated from the command line. If the program does not have a command line interface, it will
not work.



Precautions - About Quotation Marks and Delimitersin CSV Format

The following ASCII code tables show the "quotation mark” and the "delimiter” character values that can be used with the CSV format.

ASCI| codetables

o|l1|2|3|4]|]5)|6]|7
0 SPlO0O|@| P p
1 ! 1A | Q| al]aq
2 "12|B|R|Db]|Tr
3 #1 3| C|S|c S
4 $|14|D|T|d|t
5 % | 5 E | U e u
6 & 6 F |V f \
7 716lw|lgl|w
8 (| 8|H|X|h|x
9 Y L9 |1 Y | i y
A * J | z j z
B + 1 K[| k|{
C , < L \ | |
D - = | M| ] m | }
E > | N | A n =
F / 210 _1]o
usable
disabled
Note 1) When the quotation mark character and the delimiter are specified by the same code, the conversion result cannot be guaranteed.
Note 2) When the same character as the delimiter existsin a character item and a numeric item that does not use the quotation mark character, the

Note 3)

conversion result cannot be guaranteed.
Refer to CSV details and setting dialog box for the method of specifying 0x09.



Precautions - Conversion of XML Files

Precautions for converting into XML format are as follows.

- Conversion from XML format to another format is a beta function.

- Intheoutput of XML format, the XML declaration is not added by not selecting atemplate filein XML Information setting.

- Conversion will be done for the valid XML file (which needs DTD).

- Awell formed XML file (which does not need DTD) can be converted if it has a clear structure.

- An XML filethat cannot be analyzed by Fujitsu XML Library cannot be read.

- XML filesthat cannot express the structure of avalid XML file in the layout definition cannot be read.

- Inthe conversion from the XML form to another form, the error number may be returned by the errors occurring while analyzing the XML file.

The content of the error No error is asfollows.

Error Values | Contents

-1| Failed to generate the DOM manager.

-22 | The area of item information on the layout file is not opened.

-23| The areafor the data acquisition of each record is not opened.

-24 | Capacity shortage of the disk occurred when opening the layout file.

-25| The error of the file access prohibition occurred when opening the layout file.

-26 | A file undefined error occurred when opening the layout file.

-27 | Aninvalid path error occurred when opening the layout file.

-28 | The error of the exceeeding numbers of opened files occurred when opening the layout file.

-29 | A file undefined error occurred when opening the layout file.

-30| A file exclusion error occurred when opening the layout file.

-31 | The error occurred when opening the layout file.

-32 | Failed to get the development area of item information on the layout file.

-35 | Failed to get the number of areas for the record data return.

-36 | Failed to get the area for the record data return.

-37 | Failed to read the layout file.

-38 | The input data form of the specified layout fileisnot XML data.

-51 | Capacity shortage of the disk occurred when opening the XML file.

-52 | A file access prohibition error occurred when opening the XML file.

-53| A file undefined error occurred when opening the XML file.

-54| Aninvalid path error occurred when opening the XML file.

-55| The error of the exceeeding numbers of opened files occurred when opening the XML file.

-56 | A file undefined error occurred when opening the XML file.

-57 | A file exclusion error occurred when opening the XML file.

-58 | The error occurred when opening the XML file.

-60 | A tag other than the route tag do not exist in the specified XML file.

-61 | There is aproblem in the grammar in the XML file of the reading object.

-63 | Corresponding tag to the record name of the specified layout file does not exist in the XML file.

-99 | Failed to get the tag specified for the retrieval key.




Notes on the Record Extraction Function

Notes on the Record Extraction function are provided below.
Notes on using the Set Data Conditions dialog box

If you modify the layout definition file after specifying one or more data conditions on the Set Data Conditions dialog box, you must check the data
conditions. It is recommend that you delete all of the data conditions and then re-specify them.

Record extraction cannot be performed under the following conditions. If either of the following conditions exists, an error message is displayed when
the dialog box is opened.

- Thedatain theinput file contains a null display area, and the Add NULL display area checkbox (input) is checked on the Basic Information dialog box
of the Layout Definition Function.

- Thebinary datain the input file is to be handled based on Big Endian ordering, and the Treat Binary on Big Endian Ordering checkbox (input) is
checked on the Basic Information dialog box of the Layout Definition Function.

Notes on specificationsin the Set Data Conditions dialog box

- If you specify a conditional value for a non-unique item name, the record extraction is performed on the first detected item having the specified name.
For correct record extraction, make item names unique within the layout definition.

- If aspace or commais used for the item name in the layout definition, record extraction cannot be performed.

- Sincethe areaallowed for entry of the conditional value is 150 bytes, a complete match will be impossible for data items that exceed 150 bytes. Use
Truncation instead.

- If you specify a non-character code in the conditional value (for example by using the Windows cut and paste function), the operation of the record
extraction function is unpredictable. To detect control characters, use the Hexadecimal Specification.

- If aconditional valueis specified for a variable-occurrence item, record extraction is performed on the first occurrence of the item. To perform record
extraction on all occurrences of the item, take the necessary action -- e.g., expand the variable-occurrence item in the layout definition and define the
conditional value for each occurrence of theitem.

- Hexadecimal Specification is not applicable for numeric type items.

Conversion Results File and Unextracted Records File

- When conversion results are to be output to multiple files (one file for one record), records ineligible for record (file) extraction will not be output. In
other output formats, an empty (0 bytesin size) conversion results file will be created if there is no record eligible for extraction. However, if CSV
item header output or the XML root tag or template is specified, the specified information will be output.

- If theinput file format is an indexed file or XML file, the unextracted records file will not be created even if so specified.

- Output to the unextracted recordsfile is not supported if more than one input file exists. Only unextracted records for the last processed input file will
be output.

Numeric value conversion for comparison against conditional value (for numeric-type attribute data)

- When thefileformat is CSV or XML, Data Converter considers NULL asO.

- For the sign part of the numeric data of an external/internal decimal item, a strict comparison is performed only on the negative sign part. Otherwise,
the sign is considered positive. (Unsigned data is aways considered positive.)

- For numeric value conversion for comparison against conditional value, the number of characters will not be checked strictly. Even if numeric data
within theinput file is abnormal, Data Converter performs numeric value conversion assuming that the datais normal. Therefore, expected extraction
may not be assured.

- Example:
PIC 9(6) COMP3.
When the input data (in hexadecimal) is 1234567C,
the record extraction function considers it as a 7-digit numeric value of +1234567.



Precautions - Multi Layout Function

Precautions of Multi Layout Function are as follows:

- TheMulti Layout Function does not support an XML format file as an input file.

When thefile format of the input file is Binary, you cannot convert the file correctly if the file has line feed codes expressed with 0x0dOa or 0xOa,
because the position of aline feed code is regarded as the end of the record.

- The COBOL runtime system must support input and output of valiable length files for converting amulti format file.

When you specify a character string enclosed in double quotations in the minimum/maximum field of the Layout Definition dialog box, the character
code of the input file should be ASCII.

When you read an existing Layout Definition File for inserting or adding a new layout file, the data format of input/output files should be the same as
other layout definitions.

When you analyze an existing COBOL library to create a new layout definition, the input/output data format that is the same as other layout
definitionsis applied to the new layout definition automatically.



Precautions - Non-Conversion Output Function for the same character code files

Precautions of the Non-Conversion Output Function are as follows:

- When theinput arealength is longer than the output area length, the part of input data that exceeds the output area length will be truncated. In this case,
Data Converter does not report digit size errors.

- When theinput area length is shorter than the output area length, Data Converter inserts NULL in the part of output data that exceeds the input area
length.

- For variable-length character items:
- for input, the valid data length will be the input data length.
- for output, if theinput file format is Data, the valid data length will be the input data length.
- for output, if theinput file format is CSV, the end of the datawill be the next NULL position.

Note:

When the input area length is longer than "the output arealength - 2", the part of the input data that exceeds "the output area length - 2" will be
truncated. In this case, Data Converter does not report digit size errors.

When the input area length is shorter than "the output area length - 2", Data Converter sets NULL in the part of output data that exceeds the input area
length.

- Data Converter converts numeric item data normally.

- Data Converter does not support XML file input/output.



GLOSSARY

COBOL File

COPY Library

CSV format

XML format

DTD

Unicode Byte Order Marker
Binary or Text file

Endian

Item extension information
Data File Format

Data file conversion

Text conversion

Null display region
Conversion Error File
Conversion Information File
User definition tranglation table
Layout Definition File



COBOL
File

Q@
o
<

Data Converter directly supports the following COBOL file organizations:

- Sequentia

- Line Sequential
- Relative

- Indexed

Any file made by a COBOL program on a general purpose machineis treated as a general COBOL filein Data Converter.

COBOL (COPY) Library

A COBOL source file which, for Data Converter purposes, contains a record description.

CSV Format

Comma-Separated Values format. Datais stored in text form, with data items separated by commas. Data Converter allows you to configure other
characters to be used as separators.

CSV format files are generally used for exchanging data with spreadsheets and relational databases.

Y ou may indicate whether afileisin CSV format or a COBOL Data File Format in the Layout Definition Utility.

XML Format

i

XML document format. The XML document is created by converting the Item name from the COBOL layout definition into XML tags and attributes.

DTD

DTD (XML Document Type Definition) defines elements and data structures of XML documents.

Oracle

Relational database management system (RDBMS) from Oracle Co.

RDBM S

Abbreviation for "Relational Database Management System": software that manages arelational database. Relational databases store data as a set of
rows, organizing the rows into related tables, and allowing data to be combined, extracted, or deleted based on information contained within, or
derived from, a set of rows.

Unicode Byte Order Marker

I

A code added to the beginning of a Unicode file to identify whether it is of type UCS2 (Little Endian), UCS2 (Big Endian), or UTF8.

| Relational database management system (RDBMS) from Microsoft Co.

| Relational database management system (RDBMYS) from Fujitsu.

Binary or Text
file

Data Converter defines "Binary or Text" files as any non-COBOL file. The following are Binary or Text files.
- Binary fileimported from a Windows/Intel or UNIX system.

- Binary file exported to a Windows/Intel or UNIX system.



- Text file created by Windows (DOS) or UNIX

A term used to describe the internal format of binary numbers. There are two formats, "Big Endian” and "Little Endian”. The format used is
determined by the machine and operating system.

Big Endian | Numbers are stored so that the higher address bytes contain the least significant digits. Big Endian is found on machines such as
UNIX/SPARC and other machines.

Little Endian | Numbers are stored so that the higher address bytes contain the most significant digits. Little Endian is found in Windows/Intel
compatible machines.

Item Extension I nfor mation

Additional information used to guide the conversion of items: it can be displayed and edited using the Layout Definition Utility.

Data File For mat

File format in which dataitems are defined only by their byte position within records.
Files created by COBOL programs are in this format. An optional alternativeis"CSV" format, in which dataitems are of variable length and
separated by commas.

Data File Conversion

A file conversion mode for all conversions other than those involving text files. Data File Conversion modeis used for conversionsinvolving "CSV"
(comma-separate values) files.

Text Conversion

A file conversion mode for files containing only text. Data Converter supports conversion of fixed or variable length format text files, in ASCII or
EBCDIC codes, with CR/LF or LF as variable length record terminators.

Null display

area

A 2 byte area added at the beginning of items and used by some software products. When these bytes contain hexadecimal 'OxFFFF, the following
dataisignored by Data Converter; when the bytes contain hexadecimal '0x0000', they are processed by Data Converter.

Conversion Error
File

When conversion errors occur, Data Converter stores information about the errorsin atext file with an .ERR extension. Y ou can check the error
information with atext file editor such as Notepad. Within Data Converter, you may view the file by clicking on the Display Errors button.

Conversion Information

File

If you save the conversion information in afile with a.CIF extension, Data Converter will reload the conversion information when you select the file
using the File, Open function.

User Definition Trandlation Table

A text file that contains mappings of byte values, allowing Data Converter to be used to convert files that use character codes other than standard
ASCI| or EBCDIC.

L ayout Definition
File

A file containing the detail s and mappings of input data items to output dataitems. It is created by the Layout Definition Utility and its extension is
Jlay".




Layout Definition Utility - Generate COBOL library

Specify whether to use input or output layout information to generate a COBOL library. The default setting is to use the output information.

Item Explanation
Input Generate COBOL library using the attributes of the input layout definition.
Output Generate COBOL library using the attributes of the output layout definition.



Layout Definition Function - An example of generatinga COBOL library

In the layout definition, the description of the layout definition under the edit can be output asa COBOL library.

Specify whether use the input information or the output information defined in the Layout definition to generate the COBOL Copy Book.

The output of the model COBOL library

If the data format of the output object is CSV or XML, the COBOL Library isoutput in the form of PIC 9 (1) when an attribute is a character sequence,
and PIC X (1) when an attribute is a numerical value.

Example)

Layout Definition

Lv | Repeat | Item-Name | Attribute | Sign | Length | Total digits | Decimal

0 ITEM1 X 10
0 GROUP1

1 ITEM2 X 3
1 ITEM3 X 1

0 |10 GROUP2

1 ITEM4 X 5

1 ITEMS X 5

1|5 GROUP2-1

2 ITEM6 4 2
1 ITEM7 X 2

0 ITEM8 X 20

0 |5 GROUP-3

1 ITEM9 X 8

0 ITEM10 X 1

Output COBOL Library

01 ABC-REC.
03 ITEM1 PIC X(10).
03 GROUPL.
05 ITEM2 PIC X(3).
05 ITEM3 PIC X(1).
03 GROUP2 OCCURS 10.
05 ITEM4 PIC X(5).
05 ITEM5 PIC X(5).
05 GROUP2-1 OCCURS 5.
07 ITEM6 PIC 9(2).
05 ITEM7 PIC X(2).
03 ITEM8 PIC X(20).
03 GROUP-3 OCCURSS5.
05 ITEM9 PIC X(8).
03 ITEM10 PIC X(1).




L ayout Definition Function - An example of generating DTD

In the layout definition, the description of the XML form of the layout definition under the edit can be output as DTD. Since the definition of XML is
not strictly expressible in the layout definition, generated DTD is not restricted. It may differ from the structure of the XML document generated from
the defined layout definition. Generating to the reference level of the XML document structure is recommended.

Example)

Layout Definition

Lv | Repeat | Item-Name | Attribute | XML Tag
0 ITEM1 X

0 GROUP1

1 GROUP2 N
2 ITEM2 X

2 ITEM3 X

0 GROUP3

1 ITEM4 X

1 ITEMS X

1 GROUP4

2 ITEM6 z

2 ITEM7 X

0 ITEM8 X

0 GROUP5

1 ITEM9 X A
1 ITEM10 X

0 |5 GROUP6

1 ITEM11 X

1 ITEM12 X N

Output DTD

<IELEMENT ABC-REC (ITEM1,GROUP1,GROUP3,I TEM8,GROUP5,GROUP6)>
<IELEMENT ITEM1 (#PCDATA)>
<IELEMENT GROUP1 (GROUP2)>
<!-- ELEMENT GROUP2 (ITEM2,ITEM3) -->
<IELEMENT ITEM2 (#PCDATA)>
<IELEMENT ITEM3 (#PCDATA)>
<IELEMENT GROUP3 (ITEM4, TEM5,GROUP4)>
<IELEMENT ITEM4 (#PCDATA)>
<IELEMENT ITEM5 (#PCDATA)>
<IELEMENT GROUP4 (ITEM6,I TEM7)>
<IELEMENT ITEM®6 (#PCDATA)>
<IELEMENT ITEM7 (#PCDATA)>
<IELEMENT ITEMS8 (#PCDATA)>
<IELEMENT GROUP5 (#PCDATA)>
<IATTLIST GROUPS ITEM9 CDATA #MPLIED>
<IELEMENT GROUPS6 (ITEM11+)>
<IELEMENT ITEM11 (#PCDATA)>




Data Definition Utility - Preferences

Specify the edit method when double-clicking on the layout definition screen. The default setting is to edit using the Item Definition dialog.

Item Explanation
Edit Using Item Definition The double-clicked line is edited using the Item Definition dialog.

Directly Edit the Item Definition The cell that is double-clicked is opened for input on the layout definition screen.



Conversion Wizard - Index Key Information

For indexed files, use this dialog box to specify the keys.
Keys

Keys are specified using the following format:

Offset-1, length-1 [/offset-2, length-2] ...

Offsets and lengths are numbers of bytes. Offset values start at 1.
Where keys have multiple partsuse a"/" (slash) to separate the parts.
Example: "1,10/15,5"

(Thisisatwo part key, the first part is 10 bytes long starting at the first byte, the second part is 5 bytes long starting at the 15th byte).

Duplicate Key

Check this box when duplicate keys are allowed.



Conversion Wizard - CSV Information Setup

Specify how Data Converter should handle CSV (Comma-Separated Values) files.

Item Explanation

1. Quotes Specifies the quote marks used for character strings.

2. Delimiter Specifies the delimiter between CSV fields. The default iscomma™," which isthe standard CSV delimiter.

3. Output quoted data using Specifies that quotes within character strings should be made into double quotes. For example the string: 'Label is
double quotes 'ABC'.", would be output as: 'Label is"ABC"'

4. Output null character as Specifies that character fields containing null should be output as a double quote. For example, the following data:
double quotes

02 ITEM1 PIC9(3) VALUE 100.
02 ITEM2 PIC X(5) VALUELOW VALUES.
02 ITEM3 PIC9(3) VALUE 100.

Would be output as: 100,",100, with this box checked, and 100,,100 with the box not checked.
5. Output item header in first  Only valid for output files.

record If checked Data Converter outputs the item namesin the first record of the CSV file. This makesthe CSV file
convenient to import into a spreadsheet.

When you use the "Reference settings’, these settings are automatically selected for the appropriate data store. The row numbersin the following table
correspond to those under the heading "Item™ above.

Symfoware Oracle INFORMIX SQL server Excel
1 " " (nothing) (nothing) "
2 , : , : ,
3 Yes Yes No No Yes
4 No Yes No No No
5 No No No No Yes



Conversion Wizard - XML Information Settings

Specifying an XML Format.

Menu
Function

Explanation

Add Standard Template File

If the DTD template of the Data Converter standard is added to the head of the output file according to the code system, Data Converter
checksit. One of the following two standard template files will be created.

CODE File Name
ASCII ASCII.xml
Unicode(UTF-8) [ UTF8.xml

Template File Name

Browse

* 1f you do not use atemplate file, be sure to remove the check on Add Data converter Standard Template File and clear the template file name

column.

Specifies the template file name by full path. When acurrent folder is set, arelative path can be specified.

Opensthe dialog by which the template file is selected.




Layout Definition Utility - External Decimal Sign Type

External decimal items can have the following sign types.

The sign column shows a set value when the edit isinput directly.

Sign Kind
S Yes
LEADING
T TRAILING
LS LEADING SEPARATE

TS TRAILING SEPARATE

Meaning

Sameas"T".

LEADING sign. Stored in the high order 4 bits of the first byte.
TRAILING sign. Stored in the high order 4 bits of the last byte.
LEADING SEPARATE sign. Stored in the first byte.
TRAILING SEPARATE sign. Stored in thelast byte.



Layout Definition - Layout Definition Information

The Layout Definition Information in the Multi Layout Definition is as follows:

Field

Layout Name
Condition

Offset
Length
Minimum

Maximum

Description

Specify the layout name, up to 90 bytes.

Specify the conditional expression. Thisfield isrequired.
EQ EQUAL

NOT NOT EQUAL

OTHER OTHER

NONE NONE

Specify the base position in records from which comparison of the dataisto start, from 1 to 32767. Thisfield isrequired.
Specify the comparison data length in bytes, from 1 to 32767 - Offset. Thisfield is required.

Specify the minimum value that is to be compared to the record data.

Specify a hexadecimal value or a character string enclosed in double quotations.

When the specified value length is shorter than the comparison data length specified above, Data Converter inserts NULL in the part
of the comparison data that exceeds the minimum value length.

When the specified value length is longer than the comparison data length, Data Converter truncates the part of the minimum data
that exceeds the comparison data length.

Specify the maximum value that is to be compared to the record data.

Specify a hexadecimal value or a character string enclosed in double quotations.

When the specified value length is shorter than the comparison data length specified above, Data Converter inserts NULL in the part
of the comparison data that exceeds the minimum value length.

When the specified value length is longer than the comparison data length specified above, Data Converter truncates the part of the
maximum data that exceeds the comparison data length.
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